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NPE X1000 - Języki programowania
Niniejszy dokument zawiera krótki opis języków programowania obsługiwanych przez platformę NPE X1000 wraz z
przykładami tworzenia prostej aplikacji Hello World. Obecną wersję rozszerzono o opis obsługi wejść/wyjść za pomocą
wymienionych języków oprogramowania wraz z przykładowym kodem aplikacji.

Komunikacja przez FTP
Aby umieścić gotowy program na urządzeniu można skorzystać z oprogramowania WinSCP dostępnego pod adresem●

http://winscp.net/download/winscp515.zip.
Po uruchomieniu programu należy kliknąć New i ustawić kolejno:●

File protocol: FTP●

Encryption: No encryption●

Host name: <adres_ip_NPEX1000> (domyślnie 192.168.0.101)●

Port number: 21●

User name: root●

Password: techbase●

Następnie kliknąć Save i nadać dowolną nazwę dla danej konfiguracji np. X1000FTP.●

Po dwukrotnym kliknięciu na utworzoną konfigurację zostanie nawiązane połączenie.●

Następnie należy wybrać lokalizację, w której znajduje się skompilowany program oraz lokalizację na, do której zostanie on●

przesłany.

http://winscp.net/download/winscp515.zip
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Po przeciągnięciu pliku powinno pojawić się okno ze ścieżką docelową na urządzeniu. Należy zatwierdzić przyciskiem copy.●

Pliki należy kopiować w trybie binarnym. W przypadku kopiowania plików bezpośrednio
z  systemu  Windows  może  być  konieczne  zastosowanie  konwersji  przy  użyciu
następującego polecenia:

sudo dos2unix nazwa_pliku

Komunikacja przez SSH
W celu uzyskania dostępu do terminala modułu NPE X1000 można wykorzystać aplikację Putty, dostępną pod adresem●

http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html
Po uruchomieniu w miejsce Host Name(or IP address) należy wpisać adres IP urządzenia.●

Connection type ustawić jako SSH.●

Konfigurację należy zatwierdzić przyciskiem open.●

login as: root●

password: techbase●

http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html
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Java - Hello World

Wprowadzenie do języka

Java to język programowania i platforma do tworzenia oprogramowania komputerowego wprowadzona przez firmę Sun
Microsystems. Jest to podstawowa technologia wykorzystywana w najwyższej klasy programach, w tym narzędziach, grach i
aplikacjach biznesowych. 

Java jest zainstalowana na ponad 850 milionach komputerów osobistych i miliardach urządzeń na całym świecie, w tym
urządzeniach przenośnych i telewizorach.

Źródło: http://www.java.com/pl/download/faq/whatis_java.xml

Organizacja Środowiska

Do tworzenia aplikacji w języku java można skorzystać ze środowiska Eclipse, dostępnego na stronie
http://www.eclipse.org/downloads/

Po uruchomieniu środowiska Eclipse należy utworzyć nowy projekt.●

http://www.java.com/pl/download/faq/whatis_java.xml
http://www.eclipse.org/downloads/
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Następnym krokiem jest nazwanie projektu oraz wybór środowiska JRE. W celu uruchomienia aplikacji na NPE X1000 należy●

wybrać JavaSE-1.6. Zatwierdzenie przyciskiem Finish.

W celu dodania nowego pliku/klasy należy kliknąć PPM na katalog src w oknie projektu i wybrać new → class.●
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Następnie należy nazwać tworzoną klasę.●

Nowo utworzona klasa powinna pojawić się w oknie projektu w katalogu src, aby edytować zawartość pliku wystarczy●

dwuktrotnie kliknąć LPM na jego nazwę.

Aplikacja HelloWorld.java

Kod przykładowej aplikacji wypisującej „Hello World!” na ekranie komputera:●

  public class Hello{

        public static void main(String[] args){

        System.out.print("Hello World!");
        }
  }



TECHBASE (C) NPE X1000 - Języki programowania 6/41

© 2013 TechBase Group Technical contact - support.techbase.eu 6/41

Deployment

Aby przetestować działanie napisanej aplikacji należy wybrać Run(ctrl+F11) z menu Run lub klinąć ikonę białej strzałki w●

zielonym kółku.

W celu utworzenia wykonywalnego pliku należy wybrać File → Export, a następnie wybrać z menu Java → Runnable JAR file.●
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Po kliknięciu Next pojawi się okno, w którym należy wybrać konfigurację oraz nazwa i miejsce zapisu pliku wynikowego.●

Otrzymany plik jest gotowy do uruchomienia na urządzeniu docelowym.●

Weryfikacja działania

Najpierw należy uzyskać dostęp do terminala modułu NPE X1000●

Następnie należy odszukać lokalizację naszej aplikacji oraz nadać jej uprawnienia wykonywania poleceniem:●

sudo chmod +x HelloWorld.jar

oraz uruchomić ją poleceniem●

java -jar HelloWorld.jar

Działanie programu:●
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Java wejścia/wyjścia
Istnieje możliwość sterowania wejściami i wyjściami wykorzystując język Java, szczegółowy opis dostępu do wejść/wyjść
znajduje się w rozdziale Dostęp do GPIO.

Obsługa wejść/wyjść w Java

Poniżej przedstawiono kod przykładowej aplikacji pozwalającej na odczytanie wartości konfigurowalnego wejścia/wyjścia
cyfrowego GPIO, w tym celu zaprezentowano sposób odczytania wartości na wejściu cyfrowym DINOUT16, któremu
odpowiada adres gpio72.
W celu ustawienia wartości GPIO należy wykonać szereg czynności:

Dodanie adresu gpio do pliku  /sys/class/gpio/export1.
Ustawienie kierunku gpio na in poprzez dopisanie in do pliku  /sys/class/gpio/gpio72/direction2.
Dodanie adresu gpio106 odpowiedzialnego za kierunek do pliku  /sys/class/gpio/export3.
Ustawienie kierunku gpio106 na out poprzez dopisanie out do pliku  /sys/class/gpio/gpio106/direction4.
Ustawienie wartości 0 powyższego gpio (1 dla out, 0 dla in)5.
Dodanie adresu gpio odpowiadającego zegarowi przerzutników (gpio128)6.
Ustawienie kierunku gpio128 jako out7.
Zatrzaśnięcie wartości opadającym zboczem zegara przerzutników, poprzez dopisanie wartości 1, a następnie 0 do pliku 8.
/sys/class/gpio/gpio128/value
Odczytanie wartości DINOUT16, poprzez odczytanie zawartości pliku  /sys/class/gpio/gpio72/value9.

Kod aplikacji

package npe_demo;

import java.io.*;

public class npe_demo {
        static int value;
        public static void main(String[] args) {

        FileWriter fileWriter = null;

        try{
         File export = new File("/sys/class/gpio/export");
     fileWriter = new FileWriter(export);
     fileWriter.write("72");
     fileWriter.close();
        }catch(IOException ie){};

        try{
        File gpio72dir = new File("/sys/class/gpio/gpio72/direction");
     fileWriter = new FileWriter(gpio72dir);
     fileWriter.write("in");
     fileWriter.close();
        }catch(IOException ie){};

        try{
         File export = new File("/sys/class/gpio/export");
     fileWriter = new FileWriter(export);
     fileWriter.write("106");
     fileWriter.close();
        }catch(IOException ie){};

        try{

http://morena.homeip.net/doku.php?id=npex1000:gpios
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         File gpio106dir = new File("/sys/class/gpio/gpio106/direction");
     fileWriter = new FileWriter(gpio106dir);
     fileWriter.write("out");
     fileWriter.close();
        }catch(IOException ie){};

        try{
        File gpio106val = new File("/sys/class/gpio/gpio106/value");
     fileWriter = new FileWriter(gpio106val);
     fileWriter.write("0");
     fileWriter.close();
        }catch(IOException ie){};

        try{
        File export = new File("/sys/class/gpio/export");
     fileWriter = new FileWriter(export);
     fileWriter.write("128");
     fileWriter.close();
        }catch(IOException ie){};

        try{
         File gpio128dir = new File("/sys/class/gpio/gpio128/direction");
     fileWriter = new FileWriter(gpio128dir);
     fileWriter.write("out");
     fileWriter.close();
        }catch(IOException ie){};

        try{
         File gpio128val = new File("/sys/class/gpio/gpio128/value");
     fileWriter = new FileWriter(gpio128val);
     fileWriter.write("1");
     fileWriter.close();
        }catch(IOException ie){};

        try{
        File gpio128val = new File("/sys/class/gpio/gpio128/value");
     fileWriter = new FileWriter(gpio128val);
     fileWriter.write("0");
     fileWriter.close();
        }catch(IOException ie){};

        try{
        File gpio72val = new File("/sys/class/gpio/gpio72/value");
     FileReader fr = new FileReader(gpio72val);
     value = (char)fr.read();
     fr.close();
        }catch(IOException ie){};

        System.out.println("Value is: "+(char)value);
}
}

Weryfikacja działania

Film przedstawiający działanie aplikacji odczytującej stan DINOUT16:
http://screencast.com/t/Pr977Toee

http://screencast.com/t/Pr977Toee
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Python - Hello World

Wprowadzenie do języka

Python jest językiem programowania starającym się zawrzeć w sobie najlepsze rozwiązania i intencje innych języków
programowania, które pojawiły się i były udoskonalane w przeciągu ostatniego dwudziestolecia. Jest on interpretowanym,
obiektowym, wysokopoziomowym językiem co ułatwia jego testowanie i stosowanie w sposób interaktywny.

Python to oprogramowanie typu Open-Source zarządzany przez Python Software Foundation, działające na wielu platformach,
takich jak: GNU/Linux, Mac OS czy Windows.

Źródło: http://pl.python.org/o,jezyku,python.html

Organizacja Środowiska

Należy upewnić się, że na urządzeniu znajduje się aktualna paczka Python. Listę dostępnych pakietów można wyświetlić●

poleceniem:

softmgr list

W celu pobrania i zainstalowania aktualnej paczki należy użyć polecenia:●

softmgr update python

Aplikacja HelloWorld.py

Do utworzenia skryptu w języku Python wystarczy dowolny edytor tekstu.●

Kod przykładowej aplikacji wypisującej „Hello, World!” na ekranie komputera:●

   #!/usr/bin/python
print "Hello, World!";

Plik z kodem należy zapisać z rozszerzeniem .py.●

Otrzymany plik jest gotowy do uruchomienia na urządzeniu docelowym.●

http://pl.python.org/o,jezyku,python.html
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Weryfikacja działania

Najpierw należy uzyskać dostęp do terminala modułu NPE X1000●

Następnie należy odszukać lokalizację naszej aplikacji oraz nadać jej uprawnienia wykonywania poleceniem:●

sudo chmod +x HelloWorld.py

oraz uruchomić ją poleceniem●

python HelloWorld.py

Działanie programu:●
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Python wejścia/wyjścia
Istnieje możliwość sterowania wejściami i wyjściami wykorzystując język Python, szczegółowy opis dostępu do wejść/wyjść
znajduje się w rozdziale Dostęp do GPIO.

Obsługa wejść/wyjść w Python

Poniżej przedstawiono kod przykładowej aplikacji pozwalającej na odczytanie wartości konfigurowalnego wejścia/wyjścia
cyfrowego GPIO, w tym celu zaprezentowano sposób odczytania wartości na wejściu cyfrowym DINOUT16, któremu
odpowiada adres gpio72.
W celu ustawienia wartości GPIO należy wykonać szereg czynności:

Dodanie adresu gpio do pliku  /sys/class/gpio/export1.
Ustawienie kierunku gpio na in poprzez dopisanie in do pliku  /sys/class/gpio/gpio72/direction2.
Dodanie adresu gpio106 odpowiedzialnego za kierunek do pliku  /sys/class/gpio/export3.
Ustawienie kierunku gpio106 na out poprzez dopisanie out do pliku  /sys/class/gpio/gpio106/direction4.
Ustawienie wartości 0 powyższego gpio (1 dla out, 0 dla in)5.
Dodanie adresu gpio odpowiadającego zegarowi przerzutników (gpio128)6.
Ustawienie kierunku gpio128 jako out7.
Zatrzaśnięcie wartości opadającym zboczem zegara przerzutników, poprzez dopisanie wartości 1, a następnie 0 do pliku 8.
/sys/class/gpio/gpio128/value
Odczytanie wartości DINOUT16, poprzez odczytanie zawartości pliku  /sys/class/gpio/gpio72/value9.

Kod aplikacji

#!/usr/bin/python

try:
        file = open('/sys/class/gpio/export', 'w')
        file.write('72')
        file.close()
except: pass

file=open("/sys/class/gpio/gpio72/direction", "w")
file.write("in")
file.close()

try:
        file = open("/sys/class/gpio/export", "w")
        file.write("106")
        file.close()

except:
        pass
file = open("/sys/class/gpio/gpio106/direction", "w")
file.write("out")
file.close()

file = open("/sys/class/gpio/gpio106/value", "w")
file.write("0")
file.close()
try:

        file = open("/sys/class/gpio/export", "w")
        file.write("128")
        file.close()
except:

http://morena.homeip.net/doku.php?id=npex1000:gpios
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        pass
file = open("/sys/class/gpio/gpio128/direction", "w")
file.write("out")
file.close()

file = open("/sys/class/gpio/gpio128/value", "w")
file.write("1")
file.close()

file = open("/sys/class/gpio/gpio128/value", "w")
file.write("0")
file.close()

file = open("/sys/class/gpio/gpio72/value", "r")
value = file.read()
file.close()
print("Value is: " + value)

Weryfikacja działania

Film przedstawiający działanie aplikacji odczytującej stan DINOUT16:
http://screencast.com/t/6eJhVL4o6cc

http://screencast.com/t/6eJhVL4o6cc
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Ruby - Hello World

Wprowadzenie do języka

Ruby jest językiem starannie dobranej równowagi. Jego twórca, Yukihiro “Matz” Matsumoto, połączył części jego ulubionych
języków (Perla, Smalltalka, Eiffel, Ady i Lispa) by uformować nowy język, który zbalansował programowanie funkcjonalne
wraz z programowanie imperatywnym.

Źródło: http://www.ruby-lang.org/pl/about/

Organizacja Środowiska

* Należy upewnić się, że na urządzeniu znajduje się aktualna paczka Ruby. Listę dostępnych pakietów można wyświetlić●

poleceniem:

softmgr list

Paczkę Ruby pobrać oraz zainstalować używając polecenia:●

softmgr update ruby

Poprawna instalacja zakończy się komunikatem:●

Aplikacja HelloWorld.rb

Do utworzenia skryptu w języku Ruby wystarczy dowolny edytor tekstu.●

Kod przykładowej aplikacji wypisującej „Hello, World!” na ekranie komputera:●

   #!/usr/bin/ruby
   puts 'Hello, World!';

Plik z kodem należy zapisać z rozszerzeniem .rb.●

Otrzymany plik jest gotowy do uruchomienia na urządzeniu docelowym.●

http://www.ruby-lang.org/pl/about/
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Weryfikacja działania

Najpierw należy uzyskać dostęp do terminala modułu NPE X1000.●

Następnie należy odszukać lokalizację naszej aplikacji oraz nadać jej uprawnienia wykonywania poleceniem:●

sudo chmod +x HelloWorld.rb

oraz uruchomić ją poleceniem●

ruby HelloWorld.rb

Działanie programu:●
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Ruby wejścia/wyjścia
Istnieje możliwość sterowania wejściami i wyjściami wykorzystując język Ruby, szczegółowy opis dostępu do wejść/wyjść
znajduje się w rozdziale Dostęp do GPIO.

Obsługa wejść/wyjść w Ruby

Poniżej przedstawiono kod przykładowej aplikacji pozwalającej na odczytanie wartości konfigurowalnego wejścia/wyjścia
cyfrowego GPIO, w tym celu zaprezentowano sposób odczytania wartości na wejściu cyfrowym DINOUT16, któremu
odpowiada adres gpio72.
W celu ustawienia wartości GPIO należy wykonać szereg czynności:

Dodanie adresu gpio do pliku  /sys/class/gpio/export1.
Ustawienie kierunku gpio na in poprzez dopisanie in do pliku  /sys/class/gpio/gpio72/direction2.
Dodanie adresu gpio106 odpowiedzialnego za kierunek do pliku  /sys/class/gpio/export3.
Ustawienie kierunku gpio106 na out poprzez dopisanie out do pliku  /sys/class/gpio/gpio106/direction4.
Ustawienie wartości 0 powyższego gpio (1 dla out, 0 dla in)5.
Dodanie adresu gpio odpowiadającego zegarowi przerzutników (gpio128)6.
Ustawienie kierunku gpio128 jako out7.
Zatrzaśnięcie wartości opadającym zboczem zegara przerzutników, poprzez dopisanie wartości 1, a następnie 0 do pliku 8.
/sys/class/gpio/gpio128/value
Odczytanie wartości DINOUT16, poprzez odczytanie zawartości pliku  /sys/class/gpio/gpio72/value9.

Kod aplikacji

#!/usr/bin/ruby

 File.open("/sys/class/gpio/export", 'w') { |file| file.write("72") }
 File.open("/sys/class/gpio/gpio72/direction", 'w') { |file| file.write("in") }
 File.open("/sys/class/gpio/export", 'w') { |file| file.write("106") }
 File.open("/sys/class/gpio/gpio106/direction", 'w') { |file| file.write("out") }
 File.open("/sys/class/gpio/gpio106/value", 'w') { |file| file.write("0") }
 File.open("/sys/class/gpio/export", 'w') { |file| file.write("128") }
 File.open("/sys/class/gpio/gpio128/direction", 'w') { |file| file.write("out") }
 File.open("/sys/class/gpio/gpio128/value", 'w') { |file| file.write("1") }
 File.open("/sys/class/gpio/gpio128/value", 'w') { |file| file.write("0") }
 File.open("/sys/class/gpio/gpio72/value", 'rb') { |file| $value=file.gets}
 puts "Value is: #$value"

Weryfikacja działania

Film przedstawiający działanie aplikacji odczytującej stan DINOUT16:
http://screencast.com/t/xoX0AFsUkljL

http://morena.homeip.net/doku.php?id=npex1000:gpios
http://screencast.com/t/xoX0AFsUkljL
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Lua - Hello World

Wprowadzenie do języka

Lua jest lekkim językiem skryptowym, którego głównym przeznaczeniem jest osadzanie w innych programach celem
rozszerzenia ich możliwości. Największą zaletą Lua jest prostota. Język został napisany w ANSI C, można go skompilować na
wiele różnych platform (także bare-metal). Lua znajduje swoje miejsce tam, gdzie nie zmieści się Perl, Ruby czy Python.

Źródło: http://caladan.jogger.pl/2011/01/09/lua-lekki-jezyk-skryptowy/

Organizacja Środowiska

Należy upewnić się, że na urządzeniu znajduje się aktualna paczka Lua. Listę dostępnych pakietów można wyświetlić●

poleceniem:

softmgr list

W celu pobrania i zainstalowania aktualnej paczki należy użyć polecenia:●

softmgr update lua

Poprawna operacja aktualizacji paczki powinna zakończyć się komunikatem:●

Aplikacja HelloWorld.lua

Do utworzenia skryptu w języku Lua wystarczy dowolny edytor tekstu.●

Kod przykładowej aplikacji wypisującej „Hello, World!” na ekranie komputera:●

   #!/usr/bin/lua
   print ("Hello World!")

Plik z kodem należy zapisać z rozszerzeniem .lua.●

Otrzymany plik jest gotowy do uruchomienia na urządzeniu docelowym.●

http://caladan.jogger.pl/2011/01/09/lua-lekki-jezyk-skryptowy/
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Weryfikacja działania

Najpierw należy uzyskać dostęp do terminala modułu NPE X1000.●

Następnie należy odszukać lokalizację naszej aplikacji oraz nadać jej uprawnienia wykonywania poleceniem:●

sudo chmod +x HelloWorld.lua

oraz uruchomić ją poleceniem●

lua HelloWorld.lua

Działanie programu:●
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Lua wejścia/wyjścia
Istnieje możliwość sterowania wejściami i wyjściami wykorzystując język Lua, szczegółowy opis dostępu do wejść/wyjść
znajduje się w rozdziale Dostęp do GPIO.

Obsługa wejść/wyjść w Lua

Poniżej przedstawiono kod przykładowej aplikacji pozwalającej na odczytanie wartości konfigurowalnego wejścia/wyjścia
cyfrowego GPIO, w tym celu zaprezentowano sposób odczytania wartości na wejściu cyfrowym DINOUT16, któremu
odpowiada adres gpio72.
W celu ustawienia wartości GPIO należy wykonać szereg czynności:

Dodanie adresu gpio do pliku  /sys/class/gpio/export1.
Ustawienie kierunku gpio na in poprzez dopisanie in do pliku  /sys/class/gpio/gpio72/direction2.
Dodanie adresu gpio106 odpowiedzialnego za kierunek do pliku  /sys/class/gpio/export3.
Ustawienie kierunku gpio106 na out poprzez dopisanie out do pliku  /sys/class/gpio/gpio106/direction4.
Ustawienie wartości 0 powyższego gpio (1 dla out, 0 dla in)5.
Dodanie adresu gpio odpowiadającego zegarowi przerzutników (gpio128)6.
Ustawienie kierunku gpio128 jako out7.
Zatrzaśnięcie wartości opadającym zboczem zegara przerzutników, poprzez dopisanie wartości 1, a następnie 0 do pliku 8.
/sys/class/gpio/gpio128/value
Odczytanie wartości DINOUT16, poprzez odczytanie zawartości pliku  /sys/class/gpio/gpio72/value9.

Kod aplikacji

#!/usr/bin/lua

file = io.open("/sys/class/gpio/export", "w")
        file:write("72")
        file:close()

file=io.open("/sys/class/gpio/gpio72/direction", "w")
        file:write("in")
        file:close()

file=io.open("/sys/class/gpio/export", "w")
        file:write("106")
        file:close()

file=io.open("/sys/class/gpio/gpio106/direction", "w")
        file:write("out")
        file:close()

file=io.open("/sys/class/gpio/gpio106/value", "w")
        file:write("0")
        file:close()

file=io.open("/sys/class/gpio/export", "w")
        file:write("128")
        file:close()

file=io.open("/sys/class/gpio/gpio128/direction", "w")
        file:write("out")
        file:close()

file=io.open("/sys/class/gpio/gpio128/value", "w")
        file:write("1")

http://morena.homeip.net/doku.php?id=npex1000:gpios
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        file:close()

file=io.open("/sys/class/gpio/gpio128/value", "w")
        file:write("0")
        file:close()

file=io.open("/sys/class/gpio/gpio72/value", "r")
value=file:read()
print("Value is: \n" .. value)
file:close()

Weryfikacja działania

Film przedstawiający działanie aplikacji odczytującej stan DINOUT16:
http://screencast.com/t/cHSPbxtjg1iV

http://screencast.com/t/cHSPbxtjg1iV
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Perl - Hello World

Wprowadzenie do języka

Perl jest interpretowanym językiem programowania, świetnie nadającym się do przeszukiwania i wydobywania informacji z
plików tekstowych a następnie do generowania raportów na podstawie zebranych danych. Jego autorem jest Larry Wall. Jest
to język łatwy, bardzo elastyczny, posiadający wiele cech innych języków, m. in. języka C. Jest on także często
wykorzystywany do tworzenia skryptów CGI obsługujących interakcję z użytkownikiem strony WWW.

Źródło: http://wieluk.republika.pl/s/operlu.html

Organizacja Środowiska

Należy upewnić się, że na urządzeniu znajduje się aktualna paczka Perl. Listę dostępnych pakietów można wyświetlić●

poleceniem:

softmgr list

W celu pobrania i zainstalowania aktualnej paczki należy użyć polecenia:●

softmgr update perl

Poprawna operacja aktualizacji paczki powinna zakończyć się komunikatem:●

Aplikacja HelloWorld.pl

Do utworzenia skryptu w języku Perl wystarczy dowolny edytor tekstu.●

Kod przykładowej aplikacji wypisującej „Hello, World!” na ekranie komputera:●

  #!/usr/bin/perl
  print "Hello, World!\n";

Plik z kodem należy zapisać z rozszerzeniem .pl●

Otrzymany plik jest gotowy do uruchomienia na urządzeniu docelowym.●

http://wieluk.republika.pl/s/operlu.html
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Weryfikacja działania

Najpierw należy uzyskać dostęp do terminala modułu NPE X1000.●

Następnie należy odszukać lokalizację naszej aplikacji oraz nadać jej uprawnienia wykonywania poleceniem:●

sudo chmod +x HelloWorld.pl

oraz uruchomić ją poleceniem●

perl HelloWorld.pl

Działanie programu:●
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Perl wejścia/wyjścia
Istnieje możliwość sterowania wejściami i wyjściami wykorzystując język Perl, szczegółowy opis dostępu do wejść/wyjść
znajduje się w rozdziale Dostęp do GPIO.

Obsługa wejść/wyjść w Perl

Poniżej przedstawiono kod przykładowej aplikacji pozwalającej na odczytanie wartości konfigurowalnego wejścia/wyjścia
cyfrowego GPIO, w tym celu zaprezentowano sposób odczytania wartości na wejściu cyfrowym DINOUT16, któremu
odpowiada adres gpio72.
W celu ustawienia wartości GPIO należy wykonać szereg czynności:

Dodanie adresu gpio do pliku  /sys/class/gpio/export1.
Ustawienie kierunku gpio na in poprzez dopisanie in do pliku  /sys/class/gpio/gpio72/direction2.
Dodanie adresu gpio106 odpowiedzialnego za kierunek do pliku  /sys/class/gpio/export3.
Ustawienie kierunku gpio106 na out poprzez dopisanie out do pliku  /sys/class/gpio/gpio106/direction4.
Ustawienie wartości 0 powyższego gpio (1 dla out, 0 dla in)5.
Dodanie adresu gpio odpowiadającego zegarowi przerzutników (gpio128)6.
Ustawienie kierunku gpio128 jako out7.
Zatrzaśnięcie wartości opadającym zboczem zegara przerzutników, poprzez dopisanie wartości 1, a następnie 0 do pliku 8.
/sys/class/gpio/gpio128/value
Odczytanie wartości DINOUT16, poprzez odczytanie zawartości pliku  /sys/class/gpio/gpio72/value9.

Kod aplikacji

#!/usr/bin/perl

open file, ">", "/sys/class/gpio/export" or die $!;
print file "72";
close file;

open file, ">", "/sys/class/gpio/gpio72/direction" or die $!;
print file "in";
close file;

open file, ">", "/sys/class/gpio/export" or die $!;
print file "106";
close file;

open file, ">", "/sys/class/gpio/gpio106/direction" or die $!;
print file "out";
close file;

open file, ">", "/sys/class/gpio/gpio106/value" or die $!;
print file "0";
close file;

open file, ">", "/sys/class/gpio/export" or die $!;
print file "128";
close file;

open file, ">", "/sys/class/gpio/gpio128/direction" or die $!;
print file "out";
close file;

open file, ">", "/sys/class/gpio/gpio128/value" or die $!;
print file "1";

http://morena.homeip.net/doku.php?id=npex1000:gpios
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close file;

open file, ">", "/sys/class/gpio/gpio128/value" or die $!;
print file "0";
close file;

open file, "<", "/sys/class/gpio/gpio72/value" or die $!;
while (my $value = <file>)
{
print "Value is: $value";
}
;
close file;

Weryfikacja działania

Film przedstawiający działanie aplikacji odczytującej stan DINOUT16:
http://screencast.com/t/EWqsGQm38M

http://screencast.com/t/EWqsGQm38M
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PHP - Hello World

Wprowadzenie do języka

PHP - obiektowy, skryptowy język programowania zaprojektowany do generowania stron internetowych w czasie
rzeczywistym. PHP jest najczęściej stosowany do uruchamiania skryptów po stronie serwera WWW, ale może być również
używany do przetwarzania danych z poziomu wiersza poleceń, a nawet do pisania programów pracujących w trybie
graficznym (np. za pomocą biblioteki GTK+). Implementacja PHP wraz z serwerem WWW Apache oraz serwerem baz danych
MySQL określana jest jako platforma AMP (w środowisku Linux - LAMP, w Windows - WAMP).

Źródło: http://pl.wikipedia.org/wiki/PHP

Organizacja Środowiska

Należy upewnić się, że na urządzeniu znajduje się aktualna paczka PHP. Listę dostępnych pakietów można wyświetlić●

poleceniem:

softmgr list

W celu pobrania i zainstalowania aktualnej paczki należy użyć polecenia:●

softmgr update php -b X1000stable

Jeśli wszystko przebiegło poprawnie powinien pojawić się następujący komunikat:●

http://pl.wikipedia.org/wiki/PHP
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Aplikacja HelloWorld.php

Do utworzenia skryptu w języku PHP wystarczy dowolny edytor tekstu.●

Kod przykładowej aplikacji wypisującej „Hello World!” na ekranie komputera:●

   <?php
          Echo "Hello, World!\n";
   ?>

Plik z kodem należy zapisać z rozszerzeniem .php.●

Otrzymany plik jest gotowy do uruchomienia na urządzeniu docelowym.●

Weryfikacja działania

Najpierw należy uzyskać dostęp do terminala modułu NPE X1000●

Następnie należy odszukać lokalizację naszej aplikacji oraz nadać jej uprawnienia wykonywania poleceniem:●

sudo chmod +x HelloWorld.php

oraz uruchomić ją poleceniem●

php HelloWorld.php

Działanie programu:●
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PHP wejścia/wyjścia
Istnieje możliwość sterowania wejściami i wyjściami wykorzystując język PHP, szczegółowy opis dostępu do wejść/wyjść
znajduje się w rozdziale Dostęp do GPIO.

Obsługa wejść/wyjść w PHP

Poniżej przedstawiono kod przykładowej aplikacji pozwalającej na odczytanie wartości konfigurowalnego wejścia/wyjścia
cyfrowego GPIO, w tym celu zaprezentowano sposób odczytania wartości na wejściu cyfrowym DINOUT16, któremu
odpowiada adres gpio72.
W celu ustawienia wartości GPIO należy wykonać szereg czynności:

Dodanie adresu gpio do pliku  /sys/class/gpio/export1.
Ustawienie kierunku gpio na in poprzez dopisanie in do pliku  /sys/class/gpio/gpio72/direction2.
Dodanie adresu gpio106 odpowiedzialnego za kierunek do pliku  /sys/class/gpio/export3.
Ustawienie kierunku gpio106 na out poprzez dopisanie out do pliku  /sys/class/gpio/gpio106/direction4.
Ustawienie wartości 0 powyższego gpio (1 dla out, 0 dla in)5.
Dodanie adresu gpio odpowiadającego zegarowi przerzutników (gpio128)6.
Ustawienie kierunku gpio128 jako out7.
Zatrzaśnięcie wartości opadającym zboczem zegara przerzutników, poprzez dopisanie wartości 1, a następnie 0 do pliku 8.
/sys/class/gpio/gpio128/value
Odczytanie wartości DINOUT16, poprzez odczytanie zawartości pliku  /sys/class/gpio/gpio72/value9.

Kod aplikacji

 <?php
$file = fopen('/sys/class/gpio/export', 'w');
                fwrite($file, '72');
                fclose($file);

$file = fopen('/sys/class/gpio/gpio72/direction', 'w');
                fwrite($file, 'in');
                fclose($file);

$file = fopen('/sys/class/gpio/export', 'w');
                fwrite($file, '106');
                fclose($file);

$file = fopen('/sys/class/gpio/gpio106/direction', 'w');
                fwrite($file, 'out');
                fclose($file);

$file = fopen('/sys/class/gpio/gpio106/value', 'w');
                fwrite($file, '0');
                fclose($file);

$file = fopen('/sys/class/gpio/export', 'w');
                fwrite($file, '128');
                fclose($file);

$file = fopen('/sys/class/gpio/gpio128/direction', 'w');
                fwrite($file, 'out');
                fclose($file);

$file = fopen('/sys/class/gpio/gpio128/value', 'w');
                fwrite($file, '1');
                fclose($file);

http://morena.homeip.net/doku.php?id=npex1000:gpios
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$file = fopen('/sys/class/gpio/gpio128/value', 'w');
                fwrite($file, '0');
                fclose($file);

$file = fopen('/sys/class/gpio/gpio72/value', 'r');
                $value = fread($file, 1);
                fclose($file);

                Echo "Value is: $value\n"
?>

Weryfikacja działania

Film przedstawiający działanie aplikacji odczytującej stan DINOUT16:
http://screencast.com/t/GA67VNKWT

http://screencast.com/t/GA67VNKWT
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ANSI C - Hello World

Wprowadzenie do języka

Imperatywny, strukturalny język programowania wysokiego poziomu stworzony na początku lat siedemdziesiątych XX w.
przez Dennisa Ritchiego do programowania systemów operacyjnych i innych zadań niskiego poziomu.

Źródło: https://pl.wikipedia.org/wiki/C_%28j%C4%99zyk_programowania%29

Organizacja Środowiska

Należy upewnić się, że system, na którym mamy zamiar przeprowadzić crosscompilację jest 64 bitowy. Można to zrobić●

przy pomocy polecenia:

uname -a

Wynik takiej operacji:●

Kolejnym krokiem jest pobranie odpowiedniego toolchaina. Należy pobrać●

angstrom-eglibc-x86_64-armv7a-vfp-neon-v2012.12-toolchain.gz z adresu http://www.angstrom-distribution.org/toolchains/
Pobrane archiwum należy rozpakować poleceniem:●

gunzip angstrom-eglibc-x86_64-armv7a-vfp-neon-v2012.12-toolchain.gz

Jeśli wszystko przebiegło poprawnie, pojawił się plik angstrom-eglibc-x86_64-armv7a-vfp-neon-v2012.12-toolchain.●

Należy nadal mu uprawnienia wykonywania poleceniem:●

sudo chmod +x angstrom-eglibc-x86_64-armv7a-vfp-neon-v2012.12-toolchain

Następnie uruchomić poleceniem:●

./angstrom-eglibc-x86_64-armv7a-vfp-neon-v2012.12-toolchain

Pojawi się pytanie o podanie lokaliazji docelowej dla toolchaina, domyślnie  /usr/local/oecore-x86_64, wystarczy zatwierdzić●

wciskając klawisz enter.
Następnie prośba o potwierdzenie instalacji, wystarczy zatwierdzić wciskając klawisz enter lub wpisać y i potwierdzić●

klawiszem enter.

https://pl.wikipedia.org/wiki/C_(język_programowania)
http://www.angstrom-distribution.org/toolchains/
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Poprawnie przeprowadzona operacja zakończy się komunikatem:●

Kolejnym krokiem jest pobranie i zainstalowanie oprogramowania Eclipse. Wystarczy użyć polecenia:●

sudo apt-get install eclipse-cdt

Należy uruchomić pobrane środowisko poleceniem:●

eclipse

Po uruchomieniu pojawi się okno z wyborem ścieżki, w której przechowywany będzie nasz projekt.●

Następnie należy wybrać File→New→Project●
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W kolejnym kroku wybieramy C/C++ → C Project●

Następnie nadajemy nazwę projektu np. HelloWorld, wybieramy Empty Project oraz CrossGCC i klikamy next.●
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Na kolejnym ekranie klikamy Next.●

Klikamy Finish i następnie Yes.●
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W Project Manager klikamy PPM na HelloWorld i wybieramy Build Configurations → Manage.●

W nowym oknie klikamy New.●

Należy wpisać nazwę np. CrossKompilacja oraz wybrać Existing configuration Debug i zatwierdzić przyciskiem OK.●
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Ponownie w Project Manager należy kliknąć PPM na HelloWorld i wybrać Properties.●

W C/C++ Build → Setting należy wybrać Cross GCC Compiler i w Command wpisać ścieżkę dostępu do naszego kompilatora:●

/usr/local/oecore-x86_64/sysroots/x86_64-angstromsdk-linux/usr/armv7a-vfp-neon-anstrom-linux
-gnueabi/arm-angstrom-linux-gnueabi-gcc
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Następnie w Cross GCC Compiler należy kliknąć Includes kliknąć przycisk Add i wpisać ścieżkę:●

/usr/local/oecore-x86_64/sysroots/x86_64-angstromsdk-linux/usr/include/

W następnym kroku należy wpisać w Cross GCC Linker w Command ścieżkę:●

/usr/local/oecore-x86_64/sysroots/x86_64-angstromsdk-linux/usr/armv7a-vfp-neon-anstrom-linux
-gnueabi/arm-angstrom-linux-gnueabi-gcc
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Następnie pod Cross GCC Linker w Libraries w oknie pod Library search path należy kliknąć przycisk Add i podać ścieżkę:●

/usr/local/oecore-x86_64/sysroots/x86_64-angstromsdk-linux/usr/lib/

Kolejnym krokiem jest ustawienie w Cross GCC Assembler w Command ścieżki:●

/usr/local/oecore-x86_64/sysroots/x86_64-angstromsdk-linux/usr/armv7a-vfp-neon-anstrom-linux
-gnueabi/arm-angstrom-linux-gnueabi-as
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Wszystko należy zatwierdzić przyciskiem OK.●

Ostatnim krokiem jest kliknięcie PPM na HelloWorld w Project Manager i wybranie Build Configurations → Set Active →●

CrossKompilacja.

Aplikacja HelloWorld.c

Aby dodać nowy plik do projektu w Eclipse należy kliknąć PPM na HelloWorld w Project Manager i wybrać New → File.●
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Nadajemy nazwę pliku np. hello.c●

Kod przykładowej aplikacji wypisującej „Hello World!” na ekranie komputera:●

   #include <stdio.h>
int main (void)
{
   printf("Hello World!");
   return 0;
}
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Deployment

Aby skompilować program i uzyskać wykonywalny plik wynikowy należy kliknąć Project → Build Project.●

Jeśli wszystko przebiegło poprawnie powinniśmy uzyskać komunikat Build Finished●

Utworzony plik HelloWorld jest gotowy do umieszczenia na urządzeniu NPE X1000.●

Weryfikacja działania

Najpierw należy uzyskać dostęp do terminala modułu NPE X1000●

Następnie należy odszukać lokalizację naszej aplikacji oraz nadać jej uprawnienia wykonywania poleceniem:●

sudo chmod +x HelloWorld

oraz uruchomić ją poleceniem●

./HelloWorld

Działanie programu:●
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ANSI C wejścia/wyjścia
Aby umożliwić uruchomienie aplikacji napisanej w języku C na urządzeniu NPE należy przeprowadzić operację
crosskompilacji.
Proces ten został szczegółowo opisany w rozdziale ansi_c_-_hello_world.
Natomiast sposób dostępu do wejść/wyjść NPE X1000 został opisany w rozdziale Dostęp do GPIO.

Obsługa wejść/wyjść w C

Poniżej przedstawiono kod przykładowej aplikacji pozwalającej na odczytanie wartości konfigurowalnego wejścia/wyjścia
cyfrowego GPIO, w tym celu zaprezentowano sposób odczytania wartości na wejściu cyfrowym DINOUT16, któremu
odpowiada adres gpio72.
W celu ustawienia wartości GPIO należy wykonać szereg czynności:

Deklaracja zmiennej typu FILE1.
Dodanie adresu gpio do pliku  /sys/class/gpio/export2.
Ustawienie kierunku gpio na in poprzez dopisanie in do pliku  /sys/class/gpio/gpio72/direction3.
Dodanie adresu gpio106 odpowiedzialnego za kierunek do pliku  /sys/class/gpio/export4.
Ustawienie kierunku gpio106 na out poprzez dopisanie out do pliku  /sys/class/gpio/gpio106/direction5.
Ustawienie wartości 0 powyższego gpio (1 dla out, 0 dla in)6.
Dodanie adresu gpio odpowiadającego zegarowi przerzutników (gpio128)7.
Ustawienie kierunku gpio128 jako out8.
Zatrzaśnięcie wartości opadającym zboczem zegara przerzutników, poprzez dopisanie wartości 1, a następnie 0 do pliku 9.
/sys/class/gpio/gpio128/value
Odczytanie wartości DINOUT16, poprzez odczytanie zawartości pliku  /sys/class/gpio/gpio72/value10.

Kod aplikacji

#include <stdio.h>
#include <stdlib.h>
#include <string.h>

FILE     *file_gpio;
int      value;

int main()
{

file_gpio=fopen("/sys/class/gpio/export", "w");
fprintf(file_gpio, "72");
fclose(file_gpio);

file_gpio=fopen("/sys/class/gpio/gpio72/direction", "w");
fprintf(file_gpio, "in");
fclose(file_gpio);

file_gpio=fopen("/sys/class/gpio/export", "w");
fprintf(file_gpio, "106");
fclose(file_gpio);

file_gpio=fopen("/sys/class/gpio/gpio106/direction", "w");
fprintf(file_gpio, "out");
fclose(file_gpio);

file_gpio=fopen("/sys/class/gpio/gpio106/value", "w");
fprintf(file_gpio, "0");
fclose(file_gpio);

http://morena.homeip.net/doku.php?id=npex1000:programming_languages_on_npe_x1000#ansi_c_-_hello_world
http://morena.homeip.net/doku.php?id=npex1000:gpios
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file_gpio=fopen("/sys/class/gpio/export", "w");
fprintf(file_gpio, "128");
fclose(file_gpio);

file_gpio=fopen("/sys/class/gpio/gpio128/direction", "w");
fprintf(file_gpio, "out");
fclose(file_gpio);

file_gpio=fopen("/sys/class/gpio/gpio128/value", "w");
fprintf(file_gpio, "1");
fclose(file_gpio);

file_gpio=fopen("/sys/class/gpio/gpio128/value", "w");
fprintf(file_gpio, "0");
fclose(file_gpio);

file_gpio=fopen("/sys/class/gpio/gpio72/value", "r");
fscanf(file_gpio, "%d", &value);
fclose(file_gpio);
fprintf(stdout, "Value is: %d\n", value);
return 0;
}

Weryfikacja działania

Film przedstawiający działanie aplikacji odczytującej stan DINOUT16:
http://screencast.com/t/q30rgGlRsvWx

http://screencast.com/t/q30rgGlRsvWx
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